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Before You Begin

About This Manual

This Userd Blanual provides the information that you need to install, setup, and use the
Serveron TM View software to monitor and diagnose the state of your transformer assets.

The manual is organized into chapters of increasing depth and detail. The chapters
Installing TM View and Using TM View are informal user guides. The TM View
Reference chapter provides detailed description s of all parts of the user interface. Finally,
the chapter titled Maintaining TM View Installations  provides additional information.

Note: this manual assumesyou have basic familiarity with the operating
principles of your Serveron Online Transformer Monitor . If you require
information regarding the features, operation, and installation of a Serveron
transformer monitor please review the technical documentation available at
the Serveron web sitewww.se rveron.com or contact your local distributor.
Current contact information for authorized distributors and technical support

is published on the Serveron web site.

References

1. DNP3 Guide for Serveron DGA Monitors.pdf
This is the guide for using the DNP3 prot ocol for communications with TM Series
DGA monitors.

2. TM View OPC User Guide.pdf
This is the guide for using the OPC interface of the Serveron Integrated Poller, which
is part of the TM View server and standalone installations (not the Viewer -only
installations).

3. ModBus Guide for Serveron DGA Monitors.pdf
This is the guide for using the ModBus protocol for communications with TM Series
DGA monitors.

4. TM View ODBC User Guide.pdf
This is the reference guide for using ODBC output from the Serveron Integrated
Poller installed with Server versions of TM View

5. TM View ODBC Tutorial
A short tutorial guiding the user through using ODBC to export the data polled by
TM View.

6. TM View Notifications User Guide
This is the reference guide for the Alarms Notifications, availa ble with the Server
install of TM View .
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About TM View Software

TM View is a software application for Windows® -compatible PCs. It is used to retrieve and
display data that has been collected by a Serveroron-line transformer monitor and alsoto
change settings within the monitor . TM View does not measure gasin-oil levels; the
Serveron monitor makes those measurements.TM View retrieves these measurements from
the monitor and displays them in a variety of formats . Serveron monitors measure, record,
and report the status of fault gasesin transformer insulating oil.

TM View requires an Ethernet, dial-up, direct serial or radio link from the PCto the
Serveron monitor in order to retrieve measurements and change settings. Transformer data
retrieved by TM View is stored in ordinary files on the PC.

Retrieving data does not cause the monitor to lose or delete its internal measurement

history. This allows more than one computer running TM View to remotely retrieve data
from a single Serveron monitor. Alt ernatively, the security features of TM View can be used
to restrict monitor access to a single, pivileged installation on a single computer .

Note: TM View 3.3is fully compati ble with transformer data files created by
earlier versions of TM View . After you install or upgrade to Serveron TM
View 3.3software, however, all TM View users at your site must upgrade to
version 3.3. Files created or updated with Serveron TM View 3. 3 software
cannot be viewed using TM View software version 2.x or old er. Users who
have not upgraded will be notified of an error when they attempt to view or

update these files.

Windows 2000 Support

TM View versions will support Windows 2000 only until 2010. Any version after that will
only support Windows XP, Windows Ser ver 2003, Windows Vista and Windows 7.
This version, TM View version 3.3 still supports Windows 2000.
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Figure 1. TM View User Interface Overview.

Paler Idle

Navigation pane : allows selection of the company, site, transformer or monitor for viewing.
In addition, the icons provide notification information (e .
accessibl@) about the status of monitored assets

@ttention required 6, ddata not

Viewing pane: contains one or moretabs. The tabs collectively display the state of theasset
or other item selected in the Navigation pane. Each tab contains a separate purposebuilt
display. For transformer assets, the availabletabsinclude the Status view, Gas in Oil PPM
graph, Limits view, Percent of Alarm graph, Sensor and Extractor Data graphs, Retention
Times graph, and Verification D ata graph.

Menu bar: allow s selection of user commands.

Application Tool bar: contains the End Date and Range controls.

End Date and Range controls: affect the display of data for many of the tabsthat appear in

the viewing pane, particularly the graphs.

Changing the setting of either control causes an

immediate refresh of the viewing pane to conform to the new setting. The default End Date
is the timestamp of the most recent available data while the default Range is 1 month.

Graph Toolbar: Displayed only when a graph is visible. Contains commands specific to

graphs.

Later sections of this document describe all features of the user interface in detail.
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Ins talling TM View

System Requirements

Serveron TM View requires a computer with 1 GHz Pentium -1V or higher and minimum

256MB of memory. 1024x768 or higher screen reslution is highly recommended (v isual

anomalies may occur on an 800x600 display. The video system must be configured to

display at least 256 colors. Serveon strongly recommends use of the highest color mode
available from your display subsystem. -Thi s m
bit col ckriét, owal owr3® depending on your vendor .

Installation requires approximately 150MB of hard disk space. At least50MB of additional
space should be available for normal use. Actual disk usage varies with the number of
monitored assets.

Serveron TM View is a Windows®-based application. This product works with Windows
2000, Windows XP, or Windows Server 2003 operating systems.

32-bits and 64-bits (x64 only) versions of Windows XP and Windows Server 2003 are
supported.

Windows 98, Windows ME, and Windows NT® operating systems are not supported.
Microsoft Windows Vista® is not supported.

TM View requires the Microsoft .NET Framework versi on 2.0.

Choosing an Installation Configuration

Serveron TM View may be installed in any one of three configurations: Viewer Only , Server
or Standalone. In order to choose the configuration that best meets your needs, it is helpful
to know a little about the internal organization of TM View software.

TM View is made up of two major components, the Viewer and the Poller. The Viewer is
the application you see and interact with. The Pollerwor ks " behind the scen:t
communicating with your Serveron monitor(s ) and saving the data they gather in files.

In the Viewer Only configuration, as the name implies, the Poller component is not
installed. Viewer Only installations are limited to accessing data retrieved and stored in
files by some other TM View installation. This configuration is appropriate in a workgroup
setting where some users access transformer data but do not have the need or the ability to
communicate directly with Serveron monitors from their computer.

The Server configuration is the counterpart of the Viewer configuration. It functions as the

point of communication with your Serveron monitors. A Server installation can receive

monitor data when no user is logged in. Server installations are particularly appropriate

when the host computer operates continuously and has ongoing access to the necessary
communications resources (modems, network adapters, etc.) Server installations are
frequently unattended and may be expected to o
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To install a Server configuration, you are required to specify an account identity under
which the Poller component will execute. To be successful at this task, you should have
knowledge of Windows file sharing and network security fundamentals. The account you
choose must have suficient privileges. These include the privilege to access all files
(including network files) that will be used by the Poller and also privilege to use the system -
wide portion of the Registry. In keeping with industry best practices, Serveron recommends
that you do not assign unnecessary privileges to this account.

In Server installs, the user identity and credentials used to run the Serveron Integrated
Poller must have local Administrator privileges. This is necessary for t he Poller to
successfully storeand retrieve various data items required by the program .

If these concepts are not clear to you, Serveron recommends that you create &tandalone
configuration.

In the Standalone configuration, the Poller component is installed in your Startup folder
and runs only when you are logged in. Data cannot be received from the monitor when you
are not logged in. The benefit of the Standalone configuration is that it largely eliminates
the need for special knowledge of file sharing and network security.

A Standalone installation of TM View behaves like a traditional desktop application
program. Note that this configuration is intended for use by a single user on a single
computer. If multiple user login identities will be accessing TM View on the same
computer, Serveron recommends that aServer configuration be used instead.

Install ation Procedure
Note : Administrative privilege is required to install the software.

When you insert the installation CD -ROM, TM View setup may start automatically. If it
does not, please double clickAutoRun .exein the root directory of the CD-ROM to start it.
Setup will install the necessary prerequisite software and then install TM View.

TM View requires version 2.0 of the Microsoft .NET Framework, Visual Studio 2005 and
Visual Studio 2008 redistributable packages (x86 for 32bits processors, x64 for 64bits
processors running Windows XP Pro x64 Edition), and the OPC core redistributable
package. f the installation program detects that this mandatory prerequisite is not present,
it will be installed automatically from the CD -ROM.

Serveron recommends that you use Windows Update to check for any recent updates to
Microsoft components after installing TM View on your computer.

When installation is complete, you may start TM View using either the Start menu or the
Desktop icon.
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Upgrade Procedure

Note : Administrative privilege is required to upgrade the software.

Insert the installation CD-ROM. TM View setup should start automatically. If it does not,
please double click AutoRun .EXE in theroot directory of the CD-ROM to start it. Setup will
automatically upgrade your existing installation to version 3.30of TM View .

TM Vi ew requires version 2.0 of the Microsoft .NET Framework, Visual Studio 2005 and
Visual Studio 2008 redistributable packages (x86 for 32bits processors, x64 for 64bits
processors running Windows XP Pro x64 Edition), and the OPC core redistributable
package. If the installation program detects that this mandatory prerequisite is not present,
it will be installed automatically from the CD -ROM.

Note: TM View 3.3is fully compatible with transformer data files created by
earlier versions of TM View . After you install or upgrade to Serveron TM
View 3.3software, however, all TM View users at your site must upgrade to
version 3.3. Files created or updated with Serveron TM View 3.3software
cannot be viewed using older versions of TM View softwa re. Users who
have not upgraded will be notified of an error when they attempt to view or
update these files.

Serveron recommends that you use Windows Update to check for any recent updates to
Microsoft components after upgrading to TM View version 3.30n your computer.

When installation is complete, you may start TM View using either the Start menu or the
Desktop icon.
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Using TM View

This chapter contains an informal guide to the features of TM View . Details of each part of
the user interface appear inthe TM View Reference chapter later in this manual.

Start ing TM View

Upon successfulinstallation, a TM View icon is created on the Desktop and aTM View

item is created in Start C Program Files C Serveron. Useone of these shortcuts tolaunch
TM View . The navigation pane will display the message No Files and the Welcome screen
will be displayed. The Welcome screen is shown inFigure 2. TM View 3.3Welcome Screen.

1. Serveron TM View

Ele Action Wiew Help

3 Mo Files.,

Welcome to TM View 3.3

Getting started for the first time:

1. On the File menu, click New.

2. Follow the instructions to create a new transformer data file.
3. In My Assets, select the new transformer.

4. On the Action menu, click Poll Now.

Or you may view the sample data:

1. Click the button below.

2. Inthe Browse for Folder dialog, select a destination and click Save.
3. On the File menu, click Open.

4. In the Open File dialog, select a sample file and click OK.

You may use the Help menu to view the User's Manual.

Install Sample Files

My Assets
Copyright © 2003 - 2009 Seneron Comporation. Usage Subfect to License Agreement.

Ready Poller: Idle

Figure 2. TM View 3.3Welcome Screen.

You can now install and open the sample files as describedon the Welcome screen You can
also create a new transformerdata file if your installation configuration supports this
operation (Viewer Only configurations do not support the creation of new files).
Alternatively, if this installation is an upgrade from TM View 1.62 or earlier and you have
existing transformer data files, you can open these files.
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Creating New Files (Adding an Asset)

Note: this operation is available if you selected the Standalone or Server
configuration during installation. If you selected Viewer Only, operations
that create and modify files are not available to you.

To add a new monitored asset to the navigation pane, create a new file. The file holds all
measurements and other information about the asset, its monitor, and its place in the
navigation hierarchy.

UseFile A N e w é&o create a new fle. This menu item display s the New File Creation
wizard. The first page of the wizard is shown in Figure 3. New File Creation wizard, initial
page.

Welcome to the New File
Creation Wizard

Thiz wizard will help pou create the file to hold pour
azzet and monitor data.

Click, Mext bo continue.

< Back

Cancel |

Figure 3. New File Creation wizard, initial page.

When you click Next, the wizard presents a series of pages that collect the information
required to display and communicate with a Serveron monitor. At the conclusion of the
wizard, the new asset and its monitor are added to your navigation pane for display and/or
update (polling).

For a detailed description of the wizard, see the section Configuring Communications later
in this manual.
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Opening F iles

To familiarize yourself with the TM View user interface, you may examine the sample files.
To do so,first click the Install Sample Files button on the Welcome screenor click Install
Sampl e Hithe defpémenu. Use the browse box to choose a loation (e.g. your My
Documents folder). When you click OK, the files are copied to the location you chose (e.g.,
My Documents ). You do not need the installation media to install the sample files.

Now selectO p e nféom the File menu and navigate to the location you selected in the
previous step. Selectone of the sample filesand click the Open button. The file contents are
added to the navigation pane. The viewing pane displays the Status tab shown in Figure 4.

(4. Serveron TM View E] [El El

Fille Action Yiew Help
End Date | 1/17/200G R4 Rangz | 1 Month v

Exzplorer

(R3] | Status | Gas inoil | Limits | Parcent of alarm | Rate of Change | Duval Triangle
My Assets Status for Asset (2007 T-81)

= Al Comparies
= [ﬂ} Company
B2 Site
Asset
(& Serveron
[ﬁ} Serveron Demo

Gas ppm Level Status Gas ROC Status

MNormal

[l
|

Normal

Monitor Status Data Age
24 Hours or Older

[ ]

To manually update the data from this asset, click the Action menu and select Poll Now,

__
(]
IO d: CEE

Normal

Event History - WARNING: Mo Recent Gaz Data

IR
L
119

140 1 112 113 1714 1715 1716 117

Latest Monitor Timestamp:
Monitor Serial Number:

Monitor Type:

Mozt Recent Service Required:
My Assels

Ready Poller: Idle

Figure 4. Asset selected in navigation pane and Statustab displayed in v iewing pane.

Note: since the contents of thesample file s were captured by Serveron some
time ago, the Data Age section on the Statustab warns you that the file
contents are not up-to-date and the Alarm History section displays the

messageWARNING: No Recent Gas Data .

Additional information about the Status tab can be found in the section oUsing the Asset
Status Tabé later in this manual.
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Navigati ng to Company, Sites, Assets and Monitors

The navigation pane is used to selecta company, site, transformer or monitor for display. It
is organized as ahierarchy of Company, Sites, Assets and their Monitors. Its structure is
similar to the navigation pane found in Windows Explorer and in many other software
applications and web sites.

The navigation pane remembers all the files you have opened and provides easy access to
their contents. When you open additional files, their contents are merged with existing sites
and companies if the names match.

Click on the small + adjacent to an icon to expand it. Expanding the transformer icon, for

example, displays the icon representing the monitor. If you then click the monitor icon, t he

viewing pane redraws to showtabs speci fi c to managing the moni
(scheduling and communications).

Navigation Pane Icons and Notification

Icons in the navigation pane change to notify you of conditions that may require your
attention. By default, items in the navigation pane are represented by the basicicons shown
in Figure 5.

Folder icon representing a
Company or Site

E /ﬁ
Icon representing a Transformer

Icon representing an Online
Transformer Monitor

Figure 5. Basic icons

When an alarm or caution condition is encountered on a transformer asset, or a service
required condition is encountered on a transformer monitor, the corresponding icon is
temporarily replaced by the pending n otification icon : a yellow triangle containing an
exclamation point. The pending notif ication icon is shown in Figure 6.

3 Mn representing an item that

@uires your attention

Figure 6. Pending notification icon
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After an asset or monitor with a pending notification is selected and displayedin more
detail, the icon is replaced by an acknowledged notification icon . This appears as the
original transformer or monitor icon with a tiny yellow triangle superimposed at upper
right.

The acknowledged notification icon is displayed aslong as the original condition (alarm,
caution, or service required) is present. When an update (polling operation) is performed
and the condition is cleared, the acknowledged noatification icon is replaced by the company,
site, transformer or monitor icon .

The acknowledged notification icons are shown in Figure 7.

Icon representing a Company or Site holding an
item with a condition that has been acknowledged

; M representing a Transformer condition that

has been acknowledged

Icon representing an Online Transformer Monitor
condition that has been acknowledged.

Figure 7. Acknowledged notification icons

Pending and acknowledged natification icons propagate upward in the navigation pane. If

any of the assets in a site are in a notification condition, the site icon displays the highest

priority ( pending or acknowledged ) notification icon for any of its assets. Similarly, if any

of a companyds sites are in a notification sta
highest priority icon. This behavior allows you to determine at a glance when one of your

assets or monitors requires attertion.

Finally, distinct icons are displayed for companies, sites, assets or monitors when their data
is contained in a file that cannot be accessed byTM View . These icons appear as the original
company, site, asset or monitor icon with a tiny white x on ared background superimposed
at upper right. The inaccessible file icons are shown inFigure 8.
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Icon representing a Company or Site contained in a
file or file s that are not accessible to TM View

IE Mﬂ representing a Transformer contained in a file

that is not accessible to TM View

Icon representing an Online Transformer Monitor
contained in a file that is not accessible to TM View

Figure 8. Inaccessible file icons

A file may be inaccessible because:
91 It has been moved or deleted, or

1 Itis stored on a file share that is not accessible because of an interruption in your
network service, or

You no longer have the permissions required to access the file, or

The contents of the file have become corrupted so thatTM View can no longer load
them.

When you click on an icon representing an inaccessible company, site, asset, omonitor, the
item does not become selected and the contents of the Viewing pane do not change. Instead,
a dialog box is displayed. The dialog box text provides a short explanation of the reason the
item is inaccessible, e.gfile not found .

Working with  Files
Using Legacy Files

Files created by TM View version 2.02(orear | i er ) ar e c¢onsTMvewed
3.3is compatible with legacy files.

After you install or upgrade to Serveron TM View 3.3software, all TM View users at your
site must upgrade to version 3.3. Files created or updated with Serveron TM View 3.3
software cannot be viewed using older versions of TM View software.  Users who have
not upgraded will be notified of an error when they attempt to view or update a file created
or updated by TM View 3.3

Legacy files do not contain Company, Site or Asset Name information for use in the
Navigation pane . So, starting with TM View 2.0, TM View uses the defaultwords Company,
Site, and Asset in the navigation pane. You can change thesedefault names to your actual
company, site and asset names
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To change a name, first select the Company, Site, or Asset icoin the Navigation pane and
then click R e n a mim ¢he Action menu. Updated values are stored in the file itself so the
change need only be performed once.Please see thdVlenu Commands section of this
manual for more information.

Corrupt or Invalid Files

TM View 3.3differs from earlier versions of TM View in its handling of corrupt or invalid
files. TM View 3.3generally detects and refuses to open corrupt or invalid files where
earlier versions of TM View may have provided partial functionality —or behaved incorrectly .

If you encounter a Corrupt or Invalid message when opening a legacy file, pleasesee the
Troubleshooting section of this manual or contact Serveron or your Serveron representative
for assistance. In most cases, corrupt or invalid files can be repaired without loss of data.

Removing a File from the Navigation Pane

The contents ofall the files you have created (File A N e w ¢ or opened (File A Op e n)é
are shown in the navigation pane. If you close TM View , the contents of the navigation
pane are preserved: when you restart TM View , navigation pane contents are unchanged.

If you no longer wish to view one or more assets or their monitors, you can remove them
from your navigator using File A Close. This menu item display s the Close Files dialog
shown in Figure 9.

(i Close Files x|

Select the file[z] you want to cloze, then click OF.

Aszzociated Files
Bgzet | b onitor Serial Humber | File Path |
1 Industnial [1-22-20058 for ... TGE-DS33203 C:hDocuments and Settingshall Uzers\DocumentzhS .
#2 Phasze Shifter [1-22-200... TGE-DS98204 C:hDocuments and Settingsiall Users\DocumentshS...
BIGSU [12-171-2003 for 1 ... TGE-DE93205 C:ADocuments and SettingsvAll Uszers\DocumentshS...
B4 Auta [11-12-2004 far 1 ... TGE-DS33206 C:hDocuments and SettingshAll Uszers\DocumentshS.

Figure 9. Close Filesdialog.
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Select the row(s) containing the monitor(s) you no longer wish to view and click OK. The
dialog clears and the screen is redrawn. If you close all files, the No files message is
displayed in the navigation pane and the Welcome screen appears in the viewing pane.

Sites continue to be displayed so long as they contain anyvisible transformer assets, and
companies continue to be displayed so long as they contain anyvisible sites. If you close all
the transformers within a Site, the Site will disappear from your nav igator as well.

Closing a file merely removes the file from the navigation pane. It does notdelete or alter
the file data itself. To again display information for a transformer and its monitor in TM
View, useFile A O p e nté add the file to the navigati on pane.

Using Commands

Commands (user actions) appear in the TM View menu bar. Menu items are unavailable
(6grayed outo6) when they do not applBleA o the
E x p o mend item is available only when the Viewing Pane shows data that may be

exported. Otherwise, it is grayed out .

Note: if your TM View installation is a Viewer Only configuration, all
commands that update or modify data are unavailable to you. These
commands must be performed from a Standalone or Server configuration .

The contents of the Action menu change according to the currently selected navigation item
and tab. ThecommandtoEnt e r Df@&@mple, is only available when viewing the
Gas in Oil graph that displays the DGA data. The Enter DGA command does not appear in
the menu when viewing other navigational selections or tabs.

SomeAction menu commands are always present. These commands affect theTM View
application as a whole and appear at the top of the Action menu. They include Select
Modem and Send Diagnostic Data .

All TM View commands are described in theMenu Commands section of the TM View
Reference section of this manual.

Using Tabs

This section provides an overview of the status and graphing tabs.

Using the Asset Status Tab

When a transformer asset is selected, the default (leftmost)tab presents a dashboardlike
status overview. Thetab contains colored status indicators, an Alarm History display, and
certain textual information. The tab is shown in Figure 10.
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(5. Serveron TM View

Elle Action Wiew Help

End Date | 1j17/2008 £ Range| 1 Month e

Explarer Status | Gas in Qil | Limits | Percent of Alarm | Rate of Change | Duval Triangle
My Assets Status for Asset (2007 T-81)

= al Companies
2 & Company
= E} Site
Asset (2
E} Serveron
& Serveron Demo

Gasz ppm Level Status Gas ROC Status

Normal Mormal

__ [/
[/

Monitor Status Data Age

. 24 Hours or Older

[ ]

To manually update the data Fram this asset, click the Action menu and select Poll Mo,
Event History : Mo Hecent Gas Data

WARNING
A R A
i

/9

__
O O

Normal

1 140 i 142 113 144 115 146 117
U
Latest Monitor Timestamp: | |
Monitor Serial Number: | |
Monitor Type: | |
T T —— - 5
Most Recent Service Required: | |
My Assets
Ready Poller: Idle

Figure 10. Statustab.

The groups of colored indicators on the upper left show :
1 The state of the gas PPM level alarm.

9 The state of thegas rate of change (ROClarm (Serveron model TM3, TM5 and
TM8 monitors only & Serveron TrueGas monitors do not measure rate of change).

9 The status of the monitor.

1 The data age én indication of whether data has recently been obtained from the
monitor ).

The Event History section shows the status reported by the selected monitor over the

previous several days. Thisdisplay expands to fill the available screen width and features a
slider to scroll through the time window speci
in the tool bar. The vertical bars represent the outcome of sample runs and othersignificant

monitor ing events.:

- Bars that representsuccessfulsample runs are colored green

- Bars that represent runs with a caution or alarm condition are yellow or red and
featureawar ning (yellow triangle) or error (rec

- Black bars are displayed to indicate that the monitor aborted a run due an error .
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- Service Required conditions in the monitor at the time it was polled are represented
by a blue bar with a Serveron Monitor icon with a blue exclamation point.

- White bars with a 6Vd character through it

- If the most recent data is more than about 48 hours old, the Event History label
displays WARNING: No Recent Gas Data in red.

Note: for more information about sample runs, Service Required conditions,
and other Serveron Online Transformer Monitor principles of operation,
please consult the documentation that was provided with your monitor or
visit http://www.serveron.com

To obtain detail s o &ndathempsignifitantenaniton events,amypodeshe r u n s
mouse pointer over the rectangle tile ) representing that day and click. A small dialog box
wi || be shown c¢ont aisactvtg ClikQ@Kato clear thedialog. hat dayd

The Action menu for the Status tab contains several commands. For details of these
commands, please refer to theTM View Reference chapter later in this manual.

External Monitors: TBM, TMS and LTC

The Status tab displays 3 other boxes, |l abel ed
OLTC Statuso6. These represent the status from
installed alongside the TM3, TM5 or TM8 monitors.

These monitors are connected tothe TMx through any available auxiliary input (4 -20 mA
current loop) of the TMXx.

0TBM6 stands for oOTransformer Bushing Monitoro
of a Serveron TBM connected to this TMx.

0TMS6é6 stands for O0OTempebatsoet MenTMBrboyg ®ygselé
status of a Serveron TMS system connected to this TMXx.

OLTC6 standSapo€Chahgedd, so the TB@obadervewoul d s
LTC monitor connected to this TMx.

The requirements to enable these features ares follows:
1. Only Serveron Monitors installed by approved Serveron technicians are supported.

2. The monitors must be properly configured in the TMx by the installation technician,
using the approved Serveron configuration software.

3. The monitor must also be configured in TM View, using the External Configuration
dialog.

4. This feature is only supported with Serveron TM8 , TM5 and TM3 monitors.

The External Configuration dialog is available from the Action menu, selecting the
o0Configure Ext er naThisditogshduld ons be used after tha monitor
has been polled at least once after it has been configured by the installation technician
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£ External Monitor Configuration

Highest Winding Current | Average Bushing | LTC Paosition
Enabled Status (From Maonitor)

Mame of Monitar
Higheszt Winding Current

Alarm Lewvel ] Range 0=x<10

W,

Caukion Lewvel |0

W,

Manager Application (if using Remate Deskiop, this is the path to the RDP file)

Browse, ..
Cancel

The elements of this dialog are identical for all types of monitors.

The tabs at the top of the dialog will have the same name as was configured in the TMx
when the external monitor was installed.

The name is repeated inthed Na me of Monitor 6 contr ol

By default, the alarm and caution levels are set at the minimum of the range for that input,

as defined by the installation technician, and the alarm/caution status of the monitor is
6unknownd (no status). The range is displayed
Alarm Level slider.

Using the sliders, the user can set the alarm and caution levels for the maitor.

This status is a feature of theTM View program only: there is no physical output related to
that status other than a visual indication on the status tab.

The O06Manager Applicationdé is an option availab
applicati on (provided with the monitor itself), which TM View can launch for the user, as a
convenience.

The external application needs to have been installed by the user on this computerprior to
configuring the external monitor. The O0Br owseéd bertonavigatedoltheo ws t
executable of that application.

For TMS the application is the configuration utility for the TMS, provided on a CD when the
TMS is delivered and installed.

For LTC the application is a configuration and display application provided wi th the
moniter when it is installed.
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For TBM monitors there is no Manager Application: instead, the user must use Windows
Remote Desktop to connect to the monitor. The monitor must also be connected to a TCP/IP
LAN connection, and the port 3389 must be allowed through any site firewall for the
connection to be established. The manager application for TBM is, instead, the location of
the RDP file which can be saved by the Remote Desktop Application.

Using the Graph s

The Gas in Oil PPM , Rate of Change, and Percent of Alarm graph tabs share several key
features. (The Rate of Change graph is available for Serveron model TM8 TM5 and TM3
monitors only. Serveron TrueGas monitors do not compute Rate of Change.)

The content of atypical graph tab is shown in Figure 11.

\
Graph toolbar Secondary Y DGA
(sensor) axis legend

i &£ = alzloB]s
[G raph tltle j #8 GSU (12-20-2002 for 1 month) - Gas in Oil

10000.00 18000 ®, %, - manusl DGA

1000.00

Primary Y
axis label

\ @ Hysrogen (H2)
- 12000
Fd @ Oxygen (02)
| - 11000 Methane (CH4)

" 40000 @ Carbon Monoxice (CO)
10000 | 000 Carban Diaxide (C02)
D Ethane (C2HE)

- 8000

. : o R I i
Prlmary Y (gaS L su.uu% Nitrogen (N2)
value) axis

Gas PPM

DG
1000 - 5000

- 4000 LoadGuide

_ — | 3000 Ambiert Temp (
- ST 2 + il o

- 2000

- 1000

- oo

/ . . - -10.00
X (time) axis

— 7 -40.00

1142472002 12172002 120812002 12152002
12:00 &AM 12:00 &AM 12:00 AW 12:00 AW

Figure 11. Graph tab components.

Thesegraphs display two vertical (Y) axes, one at the left and the other at the right. The
values of gasesare always displayed relative to the left or primary axis , which may be either
logarithmic or linear . Sensor readings (LoadGuide, Ambient Temperature, etg are
displayed relative to the right or secondary axis, which always displays a linear scale.

A graph legend indicating the color of each gas or sensordata series appears to the right of
the graph area. The graph legend relates colors to measured values. Carbon Monoxide
(CO), for example, is always shown in red. When a graph is first displayed, measured gas
values are shown while computed values and sensor values are hidden. The colored circle
adjacent to eachseries names in the legendis a control buttons. To display or hide a
particular gas or sensordata series,click the appropriate button.
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Serveron model TM8, TM5 and TM3 monitors support configurable labeling for external
sensors. For these models, the external sensor labels are taken from information stored in
the transformer monitor itself. The labels are normally configured when the monitor is
installed. TM View does not support the ability to change the configured labels.

When a TBM, TMS or LTC external monitor is connected and configured in the monitor, the
name configured for that moni tor will be read when the monitor is polled, and displayed on
the graph.

Serveron TrueGas monitors do not support configurable labeling, so external sensor labels
for TrueGas monitors are determined by the TM View software.

The legend information at extrem e upper right indicates that one or more manual dissolved
gas analysis (DGA) readings are currently being displayed on the graph. This legend block
appears only when manual DGA readings are being shown. On the graph surface, manual
DGA data appears as smal X markers in the color of the corresponding gas data series.To
see the numerical values of DGA data, simply slide the mouse over the area of the DGA.

For more information about the Gas in Oil PPM , Rate of Change, and Percent of Alarm
tabs, including instructions for entering manual DGA readings, see the corresponding
sectionin the TM View Reference chapter later in this manual.

Graph Toolbar

Graph tabs contain their own toolbar. It is distinct from the Application Toolbar that
contains the End Date and Range controls. The graph toolbar is detailed in Figure 12.

B & &40 AE]|o[D]s

Toggle:
Annotations

Copy to
Clipboard

Display Rogers
Ratio Viewer

Toggle: Point
Labels

Toggle: Primary
Y axis log/linear

Toggle: Data
Table

Toggle: Zoom

Figure 12. Graph Toolbar

Copy to Clipboard. This button allows the graph contents to be transferred to the Windows
Clipboard in one of three formats: bitmap, metafile, and text. Bitmap and metafile are
image formats compatible with many other applications. Text format allows the graph data
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to be copied. In most cases, better results can be achieved with th&ile € Export menu
item, which is described in the TM View Menu Commands section of this manual.

Print. This button allows the graph contents to be printed. Its behavior is identical to the
File € Print menu item, also described in the Menu Commands section.

Point Labels. This button allows point labels to be displayed or hidden. Point labels are
most useful when only a limited number of points are displayed (for example, a 3-day
view).

Data Table. TM View can display a data table which provides a tabular data view of the
data that is linked to the graph contents. The Data Table button allows the data table to be
displayed or hidden. When the mouse is moved over Data Table cells, the coresponding
point in the graph series is highlighted. When the mouse is moved over a point in the graph
series, the Data Table is automatically scrolled to display the corresponding cell and that cell
is highli ghted.

Zoom. The zoombuttonenabl es or di sabl es 0zoonoemabledgyou t he g
canclick in the graph area at the upper left corner of the area you wish to enlarge and drag

the mouse down and to the right to define the area you wish to displa y. When you release

the mouse button the selectedarea expands to fill the entire graph region and sliders

(similar to scroll bars) are displayed to allow the graph to be repositioned. You may zoom

repeatedly to magnify smaller areas or click the toggle again to restore the original

resolution.

Log Scale. The log/linear button changes the primary Y axis from a log scale to a linear
scaleand back. Display of sensor values is not affected. Sensor values are displayed
relative to the secondary Y axis, which is always linear and displays a fixed range suitable
for sensors supported by Serveron.

Display Rogers Ratio Viewer. Clicking this button displays the Serveron Rogers Ratio
Viewer, a graphical transformer diagnostic display . For more information abou t the Rogers
Ratio Viewer, seeUsing the Serveron Rogers Ratio Viewer .

Toggle Annotations. This button toggles the display of graph annotation markers .

Annotations are notes attached to particular points in time on the graph while their markers
arecartoonsty | e 0t hought bubbles. 6 To see the annot
the marker or click within the bubble.

Annotate. Clicking this button displays the Annotate dialog box, which allows you to enter
annotations (notes) that are associated with a pant in time on the graph .

Installing and Using Licenses

Your initial installation of TM View is a fully -functional application for monitoring and
managing Serveron Online Transformer monitors. In addition, Serveron offers an automatic
polling option whic h requires separate licensing.

This license provides the ability to perform automatic scheduled polling for more than one
monitor (automatic scheduled polling for a single monitor is included in the initial
installation).
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This section explains how to obtain, install, and use licenses for this extended feature. To
purchase licenses, please contact Serveron or your Serveron representative.

Overview

Licensed features are enabled through a two-step process. The process begins when you
transmit your Machine | D via email to Serveron and is completed when you receive the

license key corresponding to the desired feature. You then install the license key into your
TM View installation in order to enable the feature. Your installation has only one Machine
ID, but you must obtain one license key from Serveron for each option you wish to access.

In order to obtain a license key, you must first install TM View in either the Standalone or
the Server configuration. Requesting and installing license keys are administrative activities
that cannot be performed from a Viewer Only configuration.

To begin the process, start TM View and then click L i ¢ e n sin thegH&lp menu to display
the Licensing dialog. After a moment, the dialog box displays your Machine ID and
enables theCopy to Clipboard button.

Create an email message. Address it tasupport@serveron.com with subject License
Request. Paste the Machine ID into the body of the message. It should look like this (your
Machine ID value will be different):

Machine ID: 5F01-7C60-F31143B23A8D

Send the email message. Serveron makes every effort to respond to license key requests
within two business days, but cannot guarantee response. If you do not receive a timely
response to your email, please contact Serveron Customer Support or your Serveron
representative.

When the email response arrives from Serveron, your license key will take the form of a text
file attachment. Please save the file attachment to a known, and preferably backed up
directory on your PC or another safe location. If you are ever forced to perform a complete
re-installation of TM View , you may need to re -install your license keys.

After saving the license key file attachment, open TM View and again click L i ¢ e n sih n g é
the Help menu to display the Licensing dialog. Click the B r o w shaitéon located at left to
display a standard Open File dialog. Navigate to the license key file (the attachment you

saved). Select the file and click OK. After a short pause, TM View should respond with a

dialog stating 1 license key installed . If it does not, please try the operation again. If the
problem reoccurs, please contact Serveron or your Serveron representative.

You can now make use of the feature or features enabled by your license.

Automatic Scheduled Polling Option

TM View maintains an internal table of licenses available for automatic polling. Each
license enables automatic polling for a single monitor. When you install TM View in either
the Standalone or Server configuration, the table is initialized with one (1) license.

An automated polling license key encodes a number of additional licenses. Licenses are
available from Serveron in groups of 6, 12, or unlimited. When you install the key as
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described above, the additional licenses you purchased are placed in the internally-
managed table.

To access your automatic polling licenses, select the Company node in the navigator and
click the Polling tab. The viewing pane should show a list of monitors. Click on a monitor
(row) to select it and then click Update Automatic Polling Statusé inthe Action menu.

The Update Automatic Polling Status dialog box appears. The dialog box shows the
number of automated polling licenses available in the pool. The value is 1 when you first
install TM View. When you add licenses, the value increases bythe number of additional
licenses you purchased (6, 12, or unlimited).

Automated polling for a monitor is enabled by checking Automatically p oll this monitor in
the Update Automatic Polling Status dialog. When you click OK, one license is removed
from the internally managed table and assigned to the selected monitor. The number of
available licenses remaining in the table is reduced by one (if you purchased an unlimited
license, the table still contains an unlimited number of licenses).

If you uncheck Aut omatically p oll this monitor for an automatically polled monitor or use

File C Close to close the file, its license is automatically returned to the internally managed

table. This increases the number of available polling licenses by one. This tablebased

design allows you to o0floatoé a smaller number
monitors should you choose to do so.
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TM View Reference

This chapter contains details of every tab and menu command in the TM View user
interface. The next section descrbes the navigation pane. The tabs are discussed inthe
Viewing Pane section. Menu items are documented in the Menu Commands section that
follows. For reference, the user interface overview is shown in Figure 13.

Viewing pane

ryer e E ST BT
Hie action View Help
EndDate  [12j17/2002 =] Range [imonth |
Explorer x| otaws [Gas mnwl‘| Limis | Percent of Alarm | Duval Triangle | Sensor Data | Extiactor Data | Retention Times | Verfical
(=2 Serveron Demo

‘ End date and time range controls

a &7 alEoB]s
=1 Serveron Stories #8 GSU (12202002 for 1 month) - Gas in Oil
#38 GSU (12-20-2002 for 1 month) 00000 P

Application
Toolbar
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Figure 13. TM View User Interface Overview.

Navigation Pane

The navigation pane contains a hierarchical list (sometimes called atree) showing the
company, sites, assets and monitors defined in all the files you have opened or created. Eab
item in the navigation pane is identified by an icon. The icons are shown in Figure 14.
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Folder icon representing a
Company or Site

Mn representing a Transformer

Icon representing an Online
Transformer Monitor

Figure 14. Navigation pane icons.

To expand an icon, displaying the items it contains, click the + (plus) adjacent to a collapsed
icon. To collapse the icon, hiding the items it contains, click the d (minus) adjacent to an
expanded icon.

When you select an icon by clicking on it, the viewing pane is redrawn with tabs that are
appropriate to display information about the selected item.

Icons in the navigation pane change to notify you of conditions that may require you r
attention. For details of the alternative icons used for notification, please refer to Navigation
Panelcons and Notification .

To add to the navigation pane, click N e w éor O p e nié the File menu. To remove items,
click Cl o siathe File menu. For detailed descriptions of these commands, please see the
Menu Commands section later in this manual.

Viewing Pane

This section contains additional details about the tabs that appear in the viewing pane. The
current selection in the navigation pane determines which tabs appear in the Viewing Pane.

Your selection will most frequently be anicon representing a transformer asset. All tabs
associated with transformer assets are described in the next subsectionTransformer Asset
Tabs. Less frequently, you will select a Company, Site or Monitor icon in the navigation
pane. Tabs associated vith these selection types are described insubsequent sections,

Transformer Asset Tabs

This section discusses the tabs that appear when a transformer asset is selected in the
navigation pane.

Status Tab

The Statustab is the default when a transformer asse is selected. It displays a dashboard-
like display of the status of the selected asset. The following indicators are provided:

Gas PPM Level Status and Gas ROC Status. Thesethree-level indicators show the results
of the most recent sample obtained from the monitor. They display alarm (red) to indicate
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that the monitor encountered a gas alarm condition on the most recent sample run or
caution (yellow) to indicate a gas caution condition. If no cautions or warnings were
detected on the most recent sample run, both indicators display normal (green). If no
readings have everbeen received, all three indicators display background gray.

Rate of change (ROC) alarm status is available from Serveron model TM8, TM5 and TM3
transformer monitors only, not from Serveron TrueGas monitors.

Monitor Status . This two-level indicator displays service required (blue) to indicate that the
monitor has encountered a service required condition. The blue indicator mimics the blue
Service Required lamp on the front panel of the monitor itself. The indicator displays
normal (green) to indicate a healthy monitor. If no data has everbeen received from the
monitor, both i ndicators display background gray.

Data Age. Thisthree-level indicator shows whether gas in oil data from the monitor is up to
date or needs to be refeshed by polling the monitor. 08 8 Hours Old (green) indicates that
the timestamp of the most recently -received sample run is from 0 to approximately 8 hours
old. 88 24 Hours Old (yellow) indicates the most recent sample is more than about 8 hours
old but no older than about 24 hours. 24 Hours or Older (red) indicates that the most recent
sample is more than about 24 hours old. If no sample data haseverbeen received from the
monitor, all three indicators display background gray.

External Monitors . A three-level indicator is show n for each possible type of external

monitor which can be configured in a TMx monitor (TBM, TMS and LTC). Green means that

the data reported by the monitor through the 4 -20 mA current loop to the TMx is within

acceptable range.

Yellow and Red mean that the data from the monitor is within the Caution or Alarm range,
respectively. The | imits for Caution andé Al arm
dialog, shown previously . Theranges for the sliders are set in the TMx monitor itself when

the external monitor is configured.

Event History . This horizont al region shows the moni
rectangular blockortile di spl ays one dayods actdayabtivigs wi t h
appearing at right.

Wit hi n a day dedvettidallbas inditate ®ne significant activity by the monitor.
Most activities are sample runs, which appear as green, yellow or red bars to indicate their
most urgent outcome (normal, caution, or alarm, respectively). Service required conditions,
if any, are displayed as vertical blue bars.Aborted runs are shown as black bars. Finally,
non-sample runs are displayed as vertical white bars. Most non-sample runs are regularly -
scheduled verification runs. If no data has everbeen received from the monitor, the Event
History block is empty.

Note: for more information about sample runs, Service Required conditions,
and other Serveron Online Transformer Monitor principles of operation,
please consult the documentation that was provided with your monitor or
visit http://www.serveron.com
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. At the bottom of the screen textual information about the monitor is
is the timestamp on the most recent piece of

significant information (service required event, sample run, etc) received from the monitor.
Status

Belowthe Latest

Mo n i
and model information for reference purposes.
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mest amp,

t he

Many commands are available in the Action menu when viewing the Status tab. These
commands are documented in the Action Menu section later in this manual.

Gas in QOil
Overview

Tab

The Gas in Oil tab is shown when a transformer asset is selected Figure 15 shows the Gas

in Oil tab.
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Figure 15. Gas in Qil tah

This tab displays a graph showing the measured levels of gases. Depending on the type of
Serveron transformer monitor used (8, 5or 3 gase9), the display will include either eight or 5
or 3 gases.

The following table shows a comparison of the gases shown by the Serveron T3, TM5 and
TM8 transformer monitors. By default, gas values are plotted on a logarithmic scale. In all
cases, gas values are expressed in parts per million (ppm), gas in oil, over a selectable time
period, which is 1 month by default.
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Gas Names Model Model Model | TrueGas
TM3 T™M5 TM8

Hydrogen (H2) \Vj VvV
Oxygen (02) \% \Y
Methane (CH4) Vv vV vV Vv
Carbon Monoxide (CO) \Vj \Vj VvV
Carbon Dioxide (CO2) \Vj \Vj VvV
Ethane (C2H6) \Vj VvV
Ethylene (C2H4) \V/ \Vj \Vj VvV
Acetylene (C2H2) \V/ \Vj \Vj VvV
Nitrogen (N2) 8 Computed estimate \Vj VvV
THC V Vv
(CH4+C2H6+C2H4+C2H2)
TDCG V Vv
(H2+CO+CH4+C2H6+C2H4+C2H2)
TheGasinOil tabal so di splays the |l evels of external

ambient temperature, and oil temperature as well as several optional sensors (oil moisture
PPM, oil moisture percent relative saturation (%RS) and auxiliary temperature.)

Data from external monitors such as TBM, TMS or LTC would be displayed with the other
external sensors values, if they are configured.

Note: data from optional oil moisture and temperature sensors is displayed

only if sensors are installed and correctly configured. For more information

about oil moisture and temperature sensors, please contact your Serveron
representative.

To display or hide a particular data series, click the small colored button immediately to the
left of the series name in the graph legend. Gas values are displayed relative to the left Gas
PPM) axis, which is logarithmic by default; the left axis may be changed to linear by clicking
the Log button in the graph toolbar. Sensor values are displayed relative to the right (Sensor
Value) axis, which is linear. For more information about axis, legends, and the graph
toolbar, please seethe section Using the Graph s earlier in this manual.

The graph legend relates colors to measured values. Carbon Monoxide (CO), for example, is
always shown in red. By default, gas values gxcept Nitrogen) are shown and all sensor
values are hidden.
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Commands

When viewing a Gas in Oil graph, the Action menu contains the tab-specific commands
Ent er D@&iStart Sample Run.

SelectingEnt er DliSplags the Enter DGA Data dial og box, which contains a simple
spreadsheetlike data editor. Set the date of your manual DGA report in the Record Time
field and enter the values for the nine supported gases.You may enter multiple rows or
correct existing entries. When you click OK, the DGA data is saved and displayed on the
graph. For more details about the DGA data display, see Displaying Manual DGA Data
below.

Selecting Start Sample Run immediately contacts the monitor to begin a sample run. Since
sample runs are scheduled automatically by the monitor, use ofthis command is rarely
required.

Note: t o adj ust t he schmeaule ctickthednsoniter &onmlithe n ¢
navigation pane, then click the Sampling tab, and finally click Update
Sampling é in the Action menu. TM View displays the Update Sample
Schedule dialog box. When you click OK, TM View immediately contacts the
monitor and updates the schedule you have defined.

Values below the Lower Detection Limit (LDL)

The lower detection limit (LDL) values for Serveron model TM8 , TM5 and model TM3
monitors are specified in the Data Sheet for the respective monitor. The monitor may report
values below these levels, however, andTM View will display them. Values below the LDL
are visually distinguished by their pale translucent color . This pale color serves as a visual
reminder that uncertainty is associated with the measurement.

Displaying Manual DGA Dat a

Manual DGA data is displayed as one or more small colored X markers on the Gas in Qil
graph and on the Duval Triangle graph.

On the Gas in Oil graph, the colors match the corresponding data series, i.e. CO is
displayed in red, H2 in blue, etc.

On the Duval Triangle graph, all manual entry data is shown in various shades ofgreen,
depending on the age of the data point.

Moving th e mouse pointer near a DGA reading on the graph surface display s a popup
window showing the exact numerical value of each of the DGA measurements.

Note: if you have a Serveron model TM3 monitor, only the TM3 gases (CH4,

C2H2, and C2H4) are displayed on thegraph. You may enter values for all 9

fields in the dialog box, however. When you move the mouse over the DGA
sample area, all 9 gas in oil values are shown in the popup window.

330f 71



810164804 Rev A TM View Software User's Manual v3.3

Disabling a data series by clicking in the graph legend also disables thecorresponding DGA
value from appearing on the graph.

When DGA data is visible on the graph, a small DGA legend appears at the upper right
corner of the screen to indicate the meaning of the display.

Limits Tab

The Limits tab is shown when a transformer asset is selectedlt displays caution (warning)
and alarm limits for the eight measured gases and TDCG (TrueGas and model TM8
monitors), five measured gases (model TM5 monitor) or for three measured gases (model
TM3 monitor). Limits a re displayed for both gas in oil PPM level and gas in oil rate of
change (ROC, reported in PPM/day). This tab also displays the most recently measured
values reported by the monitor for gas in oil, rate of change, and goodness of fit (a quality
metric for the current ROC value).

Note: ROC data is available from model TM8, TM5 and TM3 monitors only .
The TrueGas monitor does not measure or report ROC data.ROC alarm and
caution limits cannot be set for the TrueGas monitor.

To change the limits, click Update Limits é in the Action menu. This display s the Update
Alarm and Caution Limits dialog box. To change a limit, click in the desired cell and type
the new value. When you click OK, the monitor is immediately updated. The viewing pane
is refreshed when the update is complete.

Percent of Alarm Tab

The Percent of Alarm tab is shown when a transformer asset is selected. It displays
measured gas values and TDCG normalized to their individual alarm or cautio n limit
values.

Example: suppose the alarm limit for H 2 is 50 PPM and the alarm limit for C2H4 is 120
PPM. Further, suppose the measured value for H2 is 40 PPM and the measured value for
C2H4 is 60 PPM. Then the displayed value for H2 will be 80 (40 PPM is 80% of the limit
value, 50 PPM) and the displayed value for C2H4 will be 50 (60 PPM is 50% of 120).

Values may be displayed relative to their caution limits instead of the ir alarm limits by
clicking one of the button s at lower right. Sensor values (LoadGuide, Ambient Temp, etc.)
do not have alarm or caution limits. Their actual values are shown relative to the right axis
for reference purposes.

No tab-specific commands are available in the Action menu when the Percent of Alarm tab
is displayed.

Rate of Change Tab

The Rate of Change tab is shown when a transformer asset is selectedand the transformer
monitor is a Serveron model TM3, TM5 or TM8. Serveron TrueGas monitors do not perform
rate of change calculations
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This tab displays the smoothed rate of change (ROC)of gas in oil values expressedin PPM
per day. ROC is not computed for sensor values (LoadGuide, Ambient Temp, etc.). Their
actual values are shown relative to the right axis for reference purposes.

No tab-specific commands are available in the Action menu when the Rate of Change tab is
displayed.

Duval Triangle Tab

The Duval Triangle is an analytical tool developed by Dr. Michel Duval of IREQ (Hydro
Quebec), Canada. The Triangle presents DGA (dissolved gas analysis) results in a graphical
form by sorting them according to a list of fa ults as codified by IEC Publication 60599,
"Mineral oil -impregnated electrical equipment in service - Guide to the interpretation of
dissolved and free gases analysis," March 1999.

For more information about the Triangle, see Using the Duval Triangle .
Sensor Data Tab

The Sensor Data tab is shown when a transformer asset is selected. It displays the values of
internal sensors. This information is intended for use by trained Customer Servic e
personnel.

No tab-specific commands are available in the Action menu when the Sensor Data tab is

displayed.

This tab is only displayed if the oO06Show Servic
Extractor Data Tab

The Extractor Data tab is shown when a transformer asset is selected. This tab displays the
status of internal sensors related to tThie tran
information is intended for use by trained Customer Service personnel .

No tab-specific commands are available in the Action menu when the Extractor Data tab is
displayed.

This tab is only displayed if the 06Show Servic

Retention Time Tab

The Retention Time tab is shown when a transformer asset is selected. The tab displays
internal information about the status of the chromatography subsystem. This information is
intended for use by trained Customer Service personnel.

No tab-specific commands are available in the Action menu when the Retention Time tab is

displayed.

This tab is only displayed if the 0Show Servic
Verification Data Tab

Overview

The Verification Data tab is shown when a transformer asset is selectedlt displays the
results of all verification runs performed in the selected time interval. Verification runs
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measure gas | evels from reference gas containe
of sample gas from the transformer asset being monitored.

Sensor data is not displayed o the Verification Data graph .

This tab is only displayed if the 0Show Servic
Commands

When viewing the Verification Data tab, the Action menu contains the tab-specific
commands Start Verification Run and Start Calibration Run .

Selecting Start Verification Run immediately contacts the monitor to begin a verification
run. Since verification runs are scheduled automatically by the monitor, use of this
command is rarely required.

Note: to adjust the monitords verification s
the navigation pane, then click the Sampling tab, and finally click Update
Sampling € in the Action menu. TM View displays the Update Sample
Schedule dialog box. When you click OK, TM View immediately contacts the
monitor and updates the schedule you have defined.

Selecting Start Calibration Run immediately contacts the monitor to begin a calibration run.

Note: Serveron monitors contain an auto-calibration feature. Manual
calibration runs should only be performed by trained Customer Service
personnel.

Company Specific Tabs

This section describes the tabs that appear when you select an organization (typicallyyour
company) in the navigation pane. Your organization is usuall y the top of the navigation
hierarchy.

Welcome Tab

The Welcome tab contains first-time startup instructions and a button that allows you to
install the sample files. Note that you may also install or reinstall the sample files at any
time by clicking the Help menu and selecting Install Sample Files .

Polling Tab

The Polling tab is the central point of administration for automatically scheduled polling.
The tab shows a row-oriented display of all monitors known to the software. Each row
contains several status columns. The display is updated every few seconds to reflect the
latest status of each monitor.

Each row in the list may be selected by clicking on it. Selecting a row enables some menu

items in the Action menu. To configure aut oma
row to select it and then chooseUpdate Automatic Polling St at &r@né&he Action menu.

This displays the Update Automatic Polling Status dialog box.
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Figure 16. Polling Tab and Update Automatic Polling Status dialog box.

The dialog box displays the number of available polling licenses. To enable automatic
polling for a monitor, click the Automatically poll this monitor ~ checkbox and then click
OK. The dialog box displays the number of available automatic polling licenses. TM View
3.3 comes with a license which supports polling automatically one single monitor.

Contact your Serveron representative to purchase a polling license for the number of
monitors you wish to poll automatically.

The Polling Period control can be used to configure the maximum polling period. TM View
will poll the monitor at least as often as the configured value. TM View may poll the
monitor more often in case of communication errors (retries) and certain monitor

conditions.

To immediatelypo | | a monitor, click thePaohbowiétfmamds r
the Action menu (the Poll Now menu item performs the same function as the Poll Now
item on the Asset Status tab.

For more information about these menu items, see theMenu Commands section of this
manual.
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Eachrow displayed by the Polling tab is composed of several fields (columns). The
following fields are shown :

Asset Name. The name of the transformer asset.
Serial Number . The serial number of Serveron monitor.

Auto Poll? This field displays Yesif the monitor is configured for automatic scheduled
polling, No if it is not.

Period. Thisfield displays the maximum period between automatic polling updates in
hours. If the unit is not configured for automatic polling ( Auto Poll column displays No),
this column retains its previous value or displays the default value of 4 hours. TM View
may contact the monitor more fre quently than the value shown in this field. For further
details, see theNext Poll subsection below.

Errors. Thisfield displays the number of communication errors that have occurred since the
monitor was last polled successfully. Each successful contat with the monitor resets the
count to O.

Successfully Called . Thisfield displays the date and time of the last successful call to the
monitor. If the monitor has not been successfully contacted, the field is empty.

Next Poll . This fields shows when the Poller component of TM View will next attempt to
contact the monitor. In the simplest case,this value is approximately the time of the last
successful call plus the value of thePeriod. The value may be different for several reasons.
Two of the most common are:

1 If a polling attempt fails, the Poller component will retry the failed attempt using an
internally defined retry algorithm.  The retry frequency may be different than the
normal polling frequency.

1 If the monitor begins sampling at an accelerated rate (e.g. hourly), the Poller will
eventually det ect t he mo randtbagin @oling merdfieequéntlyrin order
to make timely data available to you. For more information about accelerated
sampling, seeAction C Sample Hourly (Monitor selected, Sampling Tab) in the
Menu Commands section.

Status. When TM View is communicating with the monitor, this field displays the most
recent status of the conversation, e.g. downloading a record, updating the host data file, etc.
The last status is displayed within parenthesis after the communication is complete.

File Name. This field displays the name of thefil e i n whi ch the monitor d:
the host.

Status Tab

The Status tab is shown when your organization (typically, your company) is selected in the
navigation pane. The Statust ab di spl ays a flat |ist of your

not navigable.

Site Specific Tabs

This section describes the tals that appear when you select a siteicon in the navigation
pane.
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Status Tab

The Status tabisshownwh en one of your organizationds sit
pane. TheStatus tab displays a flat list of the assets of the selected site. The list is not
navigable.

Monitor Specific Tabs

This section describes the tabs that appear when you select a monitor icon in the navigation
pane. The monitor i con ihenatigatonHemwty.st or o0l eaf

Sampling Tab (Monitor icon selected in Navigation Pane)
The Sampling tab is shown when a monitor icon is selected in the navigation pane. Use this

tab to review the monitoro6s sampling and verif

Tochangethemont or 6 s sampl ing or v e Updaté Samplingémon s c hedu
the Action menu while this tab is displayed. TheUpdate Sampling Schedule dialog is

displayed. When you click OK in the dialog box, TM View immediately contacts the
monitor and updatesth e moni t or s sampling schedul e.

The Action menu for this tab also containstheSa mp | e H @ammaéany. éThe Sample
Hourly command is described in the Action € Sample Hourly (Monitor selected,
Sampling Tab) section below.

Communications Tab (Monitor icon selected in Navigation Pane)

The Communications tab is shown when a monitor icon is selected in the navigation pane.
It displays a textual summary of the communications settings for the selected transformer
monitor. Usethistabtorevi ew t he host 6s communication sett.i

To change the settings used byTM View , click Update Communications € on the Action

menu while this tab is displayed. The Update Communications Wizard is displayed. Use

the Wizard to review and update the communicati on settings. When you click Finish, TM
Viewupdates the hostdés communication settings.

To verify monitor communications, click Ch e c k Co mmu n iorctletActionnngeiu for
this tab. This command will attempt to contact the monitor and retrieve basic info rmation
about the monitor. After the command completes (or fails), a message box displays the
outcome of the test.

Menu Commands

This section provides an overview of the menu commands available in TM View .

File Menu
File A Newé

This menu item display s the New File Creation wizard to begin the creation of a new file.
Since each transformer asset and its monitor are represented in a single file, this operation is
used to add new assets and monitors to your TM View installation.

After the initial screen, the wizard displays the Monitor Information page shown in Figure
17.
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New File x|

Monitor Informabon
Enter ar modify infarmation far the new file below,

Campary Mame: |5 ErYeron j
Site Mame: |Hillshum j
Azzet Mame: |Transfurmer j
M anitor Type
(« TMEBor TM3
" True Gas
tanitar Serial Mumnber; TH3000906

< Back | Hest > | Cancel

Figure 17.Monitor Information page.

After entry of the require d information, the wizard displays the Select File page. A default
filename is composed from the last folder in which you located a file combined with the site
and asset nameyou specified. If you have not previously loc ated a file using TM View , the
location will default to your My Documents folder.

You may use the keyboard to change any part of the path or use theB r o w shbaitéon to
select a different folder in which to create the file.

The wizard then presents the Connection Type page. This pageallows you to select the
monitor &s c¢ o mmurom acrangeiofcsupportad glteraatives. When you click the
Next button, a communications configuration page specific to the selected communications
type is displayed.

The Connection Type screen requires that you know something about the way TM View
will connect to each monitor from which you will collect data.
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Update Communications (TMB001707) E|

Connection Type
Chooze the twpe of connection uzed o communicate with the maonitar.

Connection Type

" Local Area Mebwork [LAN] " R5-485
{+ Telephone modem " Telephone modem with radio [Freetave]
" R5-232 " R5-232 with radio [Freetfave]

Pratocol Option
OutStation DMP 3 Mode Address

[ Use DMP3 with this monitor
Enter a number from 1 to 255,

[ Make thiz monitor OPC-visible

¢ Back | MHest » | Cancel

Figure 17-A. Connection Type wizard page.

Some options are dependent from other choices on this page and the New Monitor
Information page.

9 LAN connections (Ethernet) are only supported for TM3, TM5 and TM8 monitor:
TrueGas monitors cannot be polled through a LAN connection. If you chose the
monitor type to be TrueGas, the LAN option will be disabled.

1 RS485 connections on aTM3, TM5 or TM8 monitor must use the DNP3 protocol: if
you select RS485,the DNP protocol option will be checked on and disabled, so it
becomes mandatory.

9 DNP3 protocol is not available for TrueGas monitors: only TM3, TM5 and TM8
monitors (TMx) with a firmware application version later or equal to 3.8 can support
DNP3 polling.

T The option oMake this monitor OPC visible i
configured to be an OPC server. In that case, all monitor selected to be OPC visible
will expose their data through an OPC interface. The OPC interface will only show
the monitors that were configured at the startup of the poller with that option

enabled.

Please consult the TM View OPC user guide for more details about enabling OPC
support for TM View .

OPC support is a functionality that requires integration with Sub -station
Automation Services.

410f 71



810164804 Rev A TM View Software User's Manual v3.3

Note: when you add a hew monitor and create a TGH file, you may be prompted to reboot
the system if ALL the following conditions are met:

1. TM View has been installed as Standalone or Server
2. You have enabled OPC support for this install ation of TM View
3. You have enable the OPGuvisible flag for this asset

If you selected LAN communication, for example, the configuration page supports entry of
a LAN (Ethernet) address. If you selected modem communications, the configuration page
supports entry of phone number, communications port, and related information.

After configuring communications, clicking the Next button will display a textual summary
of the information collected by the wizard. When the Finish button is clicked, the new file is
created and added to the navigator. It will remain in the navigator even if you exit and
restart TM View . To remove an asset and its associated monitor from the navigator,click
Cl o sie the File menu.

File A Opené

This item is used to open an existing file. It presents a standard Open File dialog. After the
file is opened successfully, it is added to the navigator. It will remain in the navigator even
if you exit and restart TM View . To remove an asset and its asociated monitor from the
navigator, useFile C Cl o0 s.e é

Note: if OPC support is enabled for this configuration of TM View and the monitor is made
OPC visible, you will be prompted to reboot the system. Changes will not be visible on OPC
until the system is restarted.

File A Cl oseé

This item is used to close (remove from display) one or more files. The files must have
previously been added to the navigator via File A N e w éor File A Op e n.é&losing the
file only removes the file fromview. T h e fconlerds@r®e not altered and the file is not
deleted.

Note: if OPC support is enabled for this configuration of TM View and the monitor is made
OPC visible, you will be prompted to reboot the system. Changes will not be visible on OPC
until the system is restarted.

File A Ar chi veé

This item is used to reduce the size of large files while preserving their data. The Choose
Archive Date dialog is displayed. Use this dialog to set the boundary date . When you click
OK, a standard file selection dialog is displayed. After you choose an archive file name and
location and click OK, all monitor data older than the boundary date is removed from the
primary data file and placed in the archive. Since archived data is no longer present in the
data file, it is no longer displayed.

If you wish to review archived data at a later date, click Open in the File menu and select
the archive file using the Open File dialog box.

Archiving your data is optional. TM View will function co rrectly even if all data ever
downloaded is allowed to accumulate in the primary data file.
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